PANASONIC Electric Works
FP Series

Ethernet (MewtocolCom) Driver

Supported version TOP Design Studio V1.0 or higher {Rl

TOP
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We would like to thank our customers for using M2I's "Touch

Operation Panel (M2] TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device”.

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

‘ Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 9

Describes how to set up communication for external devices.

5. Supported addresses Page 13

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and “PANASONIC Electric Works — FP Series Ethernet” is as follows.

Communication Communication
CPU Link I/F . Cable
method setting

3. TOP

communication

FP FP7 CPS31E Ethernet tting Twisted pair cable™ote "
settin wiste alr capble ot
(TCP/UDP) ) P
4. External device

setting

*Note 1) Twisted pair cable
- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5.
- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a

direct cable.

W Connectable configuration
+ 1:1 connection (one TOP and one external device) connection

] MR-

— [ HuB

* 1:N connection (one TOP and multiple external devices) connection

D m‘: M*E ......... M*T

| HUB |—
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H

PLC select [Ethernet]

Filter : |[AII] v‘ Search : I:I

@ Model (O Vendor

Vendor

M2I Corporation

MITSUBISHI Electric Corporation
OMRON Industrial Automation
LS Industrial Systems

MODBUS Organization

SIEMENS AG.

Rockwell Automation

GE Fanuc Automation

‘YASKAWA Electric Corporation
YOKOGAWA Electric Corporation

Schneider Electric Industries

KDT Systems
RS Automation hé
4_Back | B Next *® Cancel
Select Device [ = |
PLC Setting[ FP Series ]
Alias Name : |PLC1 BindIP: [Auto ~
Interface : |Ethernet ~
Protocel : | MewtocolCom 85 Comm Manual

String Save Mode @ |First LH HL Change

[ use Redundancy

AND v
Primary Option
. N N e :
Ethernet Protocol
Timeout msec
Send Wait msec
Station Num l:l
Command Header
HMI TCP Port
ET-LAN unuse v h
4@ Back « oK ® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Select “PANASONIC Electric Works".
PLC Select an external device to connect to TOP.

Interface Protocol

FP Series Ethernet MewtocolCom

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [ Project > Project properties > TOP settings] — [Project option > Check “"Use HMI settings” > Edit > Serial ]

— Set the TOP communication interface in TOP Design Studio.

Project Option s
-cr\angeHMHm 'Mu PLC[A) | TR Change Picicl | [ Delete PLCID)
%m Date / Time Sync. | Screen Option || Unit Convert
b 'ﬁiﬁﬁ;”l"d";d“‘(ﬁnfem”g Project Option  Screen Change  HmiSetup | Global Lock & Touch  Project Style  Splash | PLC Buffer Sync.
v -4 Device Settin
"':,_' com (D)g TS Initialization Edit
3% COM2 (0 Project Setting ~
g% COM3 (0) HMIDisable=0
v . Ethernet (1) Project Name=New project
- PLC1: FP Series Start Mode=Menu
-8 Wireless (0) f:g‘ Sucs’:i'a R
48 USBDevice (0) Latch Set=0n0
Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1
Control Panel
i o P
System -|U" Devices fl Ethernet >
-Port
amm B | --== Ethernet Port ¢ ETH1 =~ 0 <
i l (™ Link Speed : duto v
PLE Security Dat e/Tine MAC Address ¢  O0:00:00-00:00-00
IP #ddress :| 192.168.1.2
Subnet Mask :  255.255.255.0
- Gateway @ 192 .1658.0.1
cEme ) |
"I"" [+] Default Gateway
Ethernet Ser ial HOM DNS (1) |
DNS (2) ¢
e -Ethernet
E— ] n\ Prinary IP @ 192.168.1.2 =~
L A . Ping
—— . Cable Status :
Diagnost ic File Ping
Wanager Bridge Mode : Jlse Bridae
Check duplicate | Apply || Cancel
Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.1.2 192.168.1.5
Subnet Mask 255.255.255.0 255.255.255.0
Gateway 192.168.0.1 192.168.0.1
*Note 1) The network addresses of the TOP and the external device (the first three digits of the IR, 192 . 168 . 0 . 0) should match.
*Note 2) Do not use duplicate IP addresses over the same network.
* The above settings are examples recommended by the company.
Items Description
IP Address Set an IP address to be used by the TOP to use over the network.
Subnet Mask Enter the subnet mask of the network.
Gateway Enter the gateway of the network.
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(2) Communication option setting

M [ Project > Project properties > PLC settings > Ethernet > "PLC1: FP Series"]

— Set the options of the FP Series Computer Link communication driver in TOP Design Studio.

ERI2 e B X
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Praject Opticn

B cteroe it

W ~aaPicia STl Change FLCICY

E3 Delete PLCDI

v D TOP Setting

L3 5Y5 : RD1520X
Option Module Setting

USBDevice (0)

PLC Setting[ FP Series ]

Alias Name : BndIP: Auto
Interface : |Ethernet ~
Protocol @ | MewtocolCom e
String Save Mode : |First LH HL Change

[] use Redundancy

Primary Option

P |191 :HISB ‘||1 ‘||5 ‘|

Ethernet Protocol TCP -

Port

Timeout

send Wait

Station Mum

Command Header

HMI TCP Port

ET-LAN

HMI Station Num

Comm Manual

Apply Close
Items Settings Remarks
Interface Select "Ethernet”. Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.
TimeOut Set the time for the TOP to wait for a response from an external device.
SendWait Set the waiting time between TOP’s receiving a response from an external device
and sending the next command request.
Port Enter the port of the external device.
Station Num Enter the station number of the external device.

Command Header

Set the characters of the header during communication.

HMI TCP Port

Enter the TOP port during communication.

ET-LAN

Set whether the ET-LAN unit is compatible.

HMI Station Num

Enter the station number of HMI to be used for ET-LAN unit compatibility.

External device connection manual for TOP Design Studio

5/13



TO hEQIRE E AT
Touch Qperation Panel

3.2. Communication setting in TOP

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

W [ Main screen > Control panel > Ethernet ]

® A Ethernet

[System] lCheck duplicate] [ Apop | v [ Cancel ] Close K

2
@ Systen [ 7Ot Dpt ion
Ethernet Port : ETHI |~/ 0 |+
n ! Link Speed :| Auto -] J,))
L MAC Address : 00:15:1D:05:38:C5
PLC s

IP Address :| 192.1B8.77.80 Sound
Subnet Mask :[  255.255.0.0
= Gateway | 192.168.0.1 o —
I = @ Default Gateway ~
Ethernet OMS (1) ;|
DN (2) ¢

- Ethernet m

Primary |P : [ 192 .168.77.80

Diagnost ic

[ ] Y

4

HRAM
Cable Status :  ETHI Connected | [Amalvsis

Bridge Mode : []Use Bridge

—-‘—

Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.1.2 192.168.1.5

Subnet Mask 255.255.255.0 255.255.255.0

Gateway 192.168.0.1 192.168.0.1

*Note 1)The network address of TOP and the external device (the first three digits of the IP 192 . 168 . 0 . 0 ) must be the same.

*Note 2) Do not use duplicate IP addresses over the same network.

* The above settings are examples recommended by the company.

Items

Description

IP Address

Set an IP address to be used by the TOP to use over the network.

Subnet Mask

Enter the subnet mask of the network.

Gateway

Enter the gateway of the network.
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(2) Communication option setting

W [ Main screen > Control panel > PLC ]

Run

YNC
Yiewer

Screen
shot

il

ERI2 e B X
Touch Qperation Panel

=] |

2 i PLC
@ Svstem| Driver(ETH) l FLC1CFP Series) vl
T——1 | Bind IP [LAuto [~]
i Ip 192}2f (188 12 (63 2] 18012
PLL Ethernet | TCP [+
Port 0001 5
IJHRF] | Timeout 1000 |5 msec
i hornot send Wait 0 3 msec
station b =
Command F
m HMI TCP F 0002 5]
Diagnost ic ET-LAN
HMl Stati B
[System] [ Diagnostic ]Fing Tesi]

| 4eply || Cancel |

g

Items Settings Remarks
Interface Select "Ethernet”. Refer to "2. External
Protocol Select the serial communication protocol between the TOP and an external device. device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device
and sending the next command request.

Port Enter the port of the external device.

Station Num Enter the station number of the external device.
CommandHeader Set the characters of the header during communication.
HMI TCP Port Enter the TOP port during communication.

ET-LAN Set whether the ET-LAN unit is compatible.

HMI Station Num

Enter the station number of HMI to be used for ET-LAN unit compatibility.

External device connection manual for TOP Design Studio
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3.3 Communication diagnostics

W Check the interface setting status between the TOP and an external device.

- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.

- Check whether the port (ETH1/ETH2) settings you want to use are the same as those of the external device in [Control panel >
Ethernet].

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC ].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

OK Communication setting normal

Time Out Error Communication setting abnormal
- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system oK NG ) )
) ) - 1. System configuration
configuration Connection cable name oK NG
TOP Version information oK NG
Port in use oK NG
Driver name oK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG 2. External device selection
Communication 3. Communication setting
diagnostics oK NG
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway oK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG ) )
Other detailed settings oK NG 4. External device setting
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway oK NG
Check address range 5. Supported addresses
oK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

4.1 External device setting - FP7

Use “FP SERIES" Ladder Software "FPWIN GR7" to set as follows. For more detailed setting method than that described in this
example, refer to the PLC user manual

1.

2.

3.

Click Project >> FP7 configuraion to pop-up the selection function window.

Selection Of Function

Memory configuration
CPU configuration
IO map

Built-in SCU

FTP dient setting
HTTF dient setting
Mail setting
EtherMet/IF Setting

ok I

Cancel

Select Built-in-LAN to pop-up Built-in-LAN Setting window.

W Euilt-in ET-LAN Setting

FTP server

System connection information setting 1
System connection information setting 2
System connection information setting 3
System connection information setting 4
User connection information setting 1
User connection information setting 2
User connection information setting 3
User connection information setting 4
User connection information setting 5
User connection information setting 6
User connection information setting 7
User connection information setting 8
User connection information setting 9
User connection information setting 10
User connection information setting 11
User connection information setting 12
User connection information setting 13
User connection information setting 14
User connection information setting 15
User connection information setting 16

| Basic communications information E]

[ Save Setting ] [ Read Setting(Q) ]

Setting item Setting description
= Basic communications inforrnation -
Specify [Pvd or IPvE, IPvd anly ]
IPvd address autormnatic acquisition Mo
Autornaticcaly acquire IPvE address b
Home [P addre wd) 192168, 1 . 5
Subnet mask {IPvd) 28R V%R, 0 00
Default gateway (IFwd) 192 01668, 1 1
Subnet prefix length (IPwE) o
Local IP address (IPvE) fefl: 12345676 1234:5678 L
Default gateway (IPvE) fefil::1 3
TCP ULP timeout value 5
TCP zero window timer value ]
TCP resend timer value 5
IP assembly timer value 3
TCP terminator detection tirner value 20
DNS server P address Set automnatically,
Specify DMS server P 1Py | 4
Priarity DNS server 0.0 .0.0
Alternate DMS server o.0.,0.0
= Add-on
Add-on Mot use,
Web Server function Mot use,
EtherMet/IP Function Mot use,
Mo, of User Connections 16
= Routing setting
Routing setting Mot use,
Route 1 Destination netwark 1 o, 0. 0.0
Destination subnet mask 1 o, 0. 0.0 i
Home IP address (IPv4)
When disabling the |P address automatic acquisition setting, set local unit [P address,
Prohibited input {0,0,0,07 €127,0,0,0-127, 255, 255, 265) (224,0,0,0-255, 255, 255, 255)
[ ok [ cancel || ReadPc | Initialize

Set IP in Basic communications information.
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System connection information setting 1~4
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TOP (|

)

Basic communications information

User connection information setting 2
User connection information setting 3
User connection information setting 4
User connection information setting 5
User connection information setting 6
User connection information setting 7
User connection information setting 8
User connection information setting 9
User connection information setting 10
User connection information setting 11
User connection information setting 12
User connection information setting 13
User connection information setting 14
User connection information setting 15
User connection information setting 16

+E

Setting itern

= System connection information setting
Connection to use specification
Communication type
Open type (server/client)
Open type (autormatic/manual)
Operating mode setting
MEWTOCOL communications type
Horme port number
Destination setting method
Destination unit [P address
Destination part number
Unused connection disconnect time

Setting description

Use,

TCRAP

Server connection (any destination)
Open automatically
[MEWTOCOL-COM

Mot connect with FPZ ET-LAN

|3276g
se [Fwd,
0.0 .0.0
0
£000

Though there are MEWTOCOL-COM, MEWTOCOL7-COM, MODBUS-TCP, MEWTOCOL-DAT,MC protocols, TOP only

supports MEWTOCOL-COM.

It sets the PLC port.

5. In addition to System connection information setting 1~4, It can be set with User connection information setting.

-
Wl Built-in ET-LAN Setting

=

Basic communications information

SNTP

FTP server

System connection information setting 1
System connection information setting 2
System connection information setting 3
System connection information setting 4

lUser connection information setting 3
User connection information setting 4
User connection information setting 5
User connection information setting &
UUser connection information setting 7
lUser connection information setting 8
User connection information setting 9
User connection information setting 10
User connection information setting 11
User connection information setting 12
User connection information setting 13
User connection information setting 14
User connection information setting 15
User connection information setting 16

User connection information setting 1
User connection information setting 2

B

Setting itemn

Connection to use specification
Communication type

Open type (server/client)

Open type (autormnatic/manual)
Operating mode setting

Setting description

= User connection information setting 2

ze,
LDPAP

Open autornatically,
MEWTOCOL-COM

|MEWTOCOL communications type

Mot connect with FPZ ET-LAN |

In case of UDP also enter IP and PORT of TOP.
*Caution) If the MEWTOCOL communications type is set to connect with the FP2 ET-LAN, set the ET-LAN item in the HMI

communication option setting to ‘use’.

External device connection manual for TOP Design Studio
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4.1 External device setting - FP2 ET-LAN

Use the "Configurator ET", the ET-LAN unit communication setting software of “FP SERIES” to set as follows. For more detailed

setting method than that described in this example, refer to the PLC user manual

1. Click ET-LAN Unit >> Initialization Settings >> Source Settings >> Change to pop-up the Source Settings window and set
IP and the station number of PLC.

¥ untitle - Configurator ET - [m] X
File  Unit Settings  Mail Settings  View Online Option Help

D SR =22 7

- ETLAN unit Source Settings| Al nitial
™.~ | Initialization Settings EFTies AT Change nitialize |
/B System Connection Settings . i [EETET I%I
. Connection Settings MEWTOCOL station number : 1 Initialize | Help |
-2 Mail Settings Router function availabilty  : nvalid

Tirna Satting

Source Settings x Change

IIPaddress: I [ oK Initialize |

I~ fwvailable for router function PLC IP Cancel

MEWTOCOL station nurnber: |] PLC prefix  [nection! vl_

METETVE-DUTET STEE STETITY SOTEsT 00011 Change

Receive-bufter area size ! |El-’1EIEI H Initialize
Send-buffer area starting address ¢ [2C00 H
Send-buffer area size ; |DdDD H
Ready [ NUM |

2. Click Connection Settings >> Connection1 >> Change to pop-up the .Connection Settings window.

¥ untitle - Configurator ET — ] X
File  Unit Settings  Mail Settings View Online Option Help

DEH SR =237
- ET-LAN Unit

Connectionl « || [~ The connection 1to & are set by ladder program

Cennection Settings X Initialize |
Connection Mo, [ T [~ AvalbIs s seting [ OK | Help |

—Open and Communication method———— Cancel |
Communication : [TCPAP =]
Open ool <]
Function ; IWI

Source port number |D

~ Destination setlings
IP address ; o.0.0.0

Part number g |D

MEWTOCOL station number ID vl

[~ Ethernetaddres: : [00° -[00° -[00° -[00° -[00° -[00°
Unused connection cut ime @ [0 minute[]
Re-open times Hli] times
Ready [ MUM 2

*Caution) The setting "The connection 1 to 8 are set by ladder program” must be off.
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3. In the Connection Settings window, enter whether to apply the Connection setting, communication method, PLC port

number and HMI setting values.

Connection Settings X
Connection No, [ 1 [ Available this setting | | ok |
~Open and Communication method - Cancel I
Communication : |[TCP/IP ~]|
Open : ||Unpassive ~|
Function : ||[MEWTOCOL  +|
Source port number W—I PLC port number
~Destination settings
IP address . [192.088, 1,1 |"MP
Port number . [a0sg Port number
MEWTOCOL station number : [T <]| ™
[~ Ethernetaddress : [00 -[00° -[00° -[00 -[00 -[00°
Unused connection cuttime : [0 minute[s]
Re-open times /255 times
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Operand Name Bit address Word address Remarks

X Input relay X00 ~ X511F WX0 ~ WX511 *Note 1)

Y Output relay Y00 ~ Y511F WYO ~ WY511 *Note 1)

R Internal relay ROO ~ R886F WRO ~ WR886 *Note 1)
Special relay R9000 ~ R910F WR900 ~ WR910

L Link relay LOO ~ L639F WLO ~ WL639 *Note 1)
Timer(contact) TO ~ T3071 S

C counter(contact) CO0 ~ C3071 _—

SV Timer/Counter(Setting value) _— SVO0 ~ SV3071

EV Timer/Counter(Elapsed value) _ EVO ~ EV3071

DT Data register DT0.0 ~ DT10239.F DTO ~ DT10239
Special data register DT90000.0 ~ DT90511.F DT90000 ~ DT90511

LD Link register LD0.0 ~ LD8447.F LDO ~ LD8447

FL File register FLO.0 ~ FL32764.F FLO ~ FL32764

*Note 1) For X,

Y, R, and L, bit/word processing is possible. In bit processing, 1 unit is hexadecimal and 10 units is decimal.

(E.g) X12C
Word processing is preceded by a W (e.g.) WX12 = X120-X12F 16-bit data)
*Caution) The special register (DT) is only available on FP2/2SH/10SH.
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